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Page 3: Safety Precautions
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Pocket PC and ensure that you are aware of correct handling procedures. ■ The precautions
provide essential information for the protection of the user and others from possible injury and
property damage. They also provide information on the safe handling of this product .

Page 4 Limitation of liability ■ Toshiba Corporation is in no way liable for any damage
resulting from earthquakes, fire, actions on the part of a third party, other accidents beyond the
control of Toshiba Corporation or intentional acts, negligence or misuse on the part of the user
or any usage under abnormal conditions.

Page 5 ■ If the pocket PC emits an unusual smell or sound, or generates smoke, turn the
battery switch to the off position immediately and disconnect the AC adaptor from the power
outlet. Continued use of the pocket PC under any of these conditions can cause fire.

Page 6 CAUTIONS ■ When using the pocket PC with the earphone (sold separately)
connected to it, do not raise the sound volume level too high. Raising the sound to high volume
levels can impair your hearing ability. ■ If the display is broken, and the liquid crystal (liquid)
leaks out, do not touch it.

Page 7 ■ Do not disassemble, remodel, or repair. Disassembly, remodeling, or repair can
cause fire, electric shock, or injury. Please contact the dealer from whom the pocket PC was
purchased and request repair service. CAUTIONS ■ When unplugging the power plug from the
outlet, disconnect the power cord by grasping the power plug itself.

Page 8 ■ Failure or repair servicing of the Pocket PC ■ Toshiba Corporation is in no way liable
for change or loss of stored data resulting from failure or repair of the unit. Please understand
this before usage. User's Manual...

Page 9 This product was designed to fulfill the EMC (electromagnetic compatibility)
requirements for “residential, commercial and light industry environments”. Toshiba does not
approve the use of this product in working environments other than “residential, commercial
and light industry environments”. For example, the following environments are not approved:
■...

Page 10 EMC (Electromagnetic compatibility) and safety standards. However, Toshiba cannot
guarantee that this product still observes these EMC standards if options or cables not produced
by Toshiba are connected or implemented. In this case, the persons who have connected /
implemented those options / cables have to make sure that the system (PC plus options /
cables) still fulfils the required standards.

Page 11 Only peripherals complying with the FCC class B limits may be attached to this
equipment. Operation with non-compliant peripherals or peripherals not recommended by
Toshiba is likely to result in interference to radio and TV reception. Shielded cables must be
used between the external devices and the computer’s USB ports, external monitor port,...

Page 12 FCC Class B Digital Devices & Peripheral Devices (Declaration of Conformity or
Certification Authorization) Declaration of Conformity Label & Marking Requirements User
Manual must provide user information in accordance with ±15.19(a)(3), 15.21, 15.27 and
15.105(b): Instruction Manual Federal Communication Commission Interference Statement This
equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules.

Page 13: Table Of Contents
Programs... 2-14 Navigation Bar and Command Bar ... 2-15 Pop-up Menus ... 2-16 Notifications...
2-16 Enter Information on Your Toshiba Pocket PC... 2-17 Find and Organize Information... 2-26
Customize Your Toshiba Pocket PC... 2-27 Chapter 3 Microsoft Chapter 4 Microsoft Pocket
Outlook Calendar: Scheduling Appointments and Meetings ...

Page 14 Chapter 5 Companion Programs Pocket Word ... 5-1 Pocket Excel ... 5-6 MSN
Messenger ... 5-7 Windows Media Player... 5-11 Microsoft Reader... 5-12 Chapter 6 Pocket
Internet Explorer The Mobile Favorites Folder ... 6-1 Favorite Links ... 6-1 Mobile Favorites ... 6-2
Using AvantGo Channels ...
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Page 15: Chapter 1 Getting Started
■ A Calendar reminder alerts you that it is time to catch the bus. You grab your Toshiba Pocket
PC device and catch the bus just in time. Because ActiveSync keeps the information on your
device up-to-date, you leisurely review your task list, make notes about the new books and CDs
you want to buy, and read and respond to e-mail messages.

Page 16: Where To Find Information
The Quick Start Card or ActiveSync Help on your computer. To view Help, click Microsoft
ActiveSync Help. The Read Me files, located in the Microsoft ActiveSync folder on the Toshiba
Pocket PC computer and on the Toshiba Pocket PC Companion CD. http://www.pda.toshiba.com
Getting Started...

Page 17: Chapter 2 Basic Skills
TOSHIBA Pocket PC e310 Basic Skills You can easily learn to use your Toshiba Pocket PC. This
chapter describes the use and customization of your Toshiba Pocket PC. Parts Names and
Function Main unit (front view) SD Card slot Stereo Headphone Jack...

Page 18: The Cradle
The Cradle Initial Setting of Program Button Program button 1 = Calendar Program button 2 =
Tasks Program button 3 = Home Program button 4 = Contacts Program button 5 = Voice
recorder Main unit (back view) Stylus Holder Stylus User's Manual SD Card slot DC-IN Socket...

Page 19: Power Button
The battery switch supplies/cuts off the battery power to the Toshiba Pocket PC. The setting of
this switch at shipment is “stop”. When using the Toshiba Pocket PC for the first time, slide this
switch to the left (the “supply” side) with the stylus.

Page 20: How To Use The Stylus
On the pop-up menu that appears, tap the action you want to perform. When you operate the
touch screen of the Toshiba Pocket PC, use the supplied stylus. If the tip of the stylus is
damaged, do not use it. If you operate the touch screen with a damaged stylus or a ballpoint
pen, the touch screen may be damaged.

Page 21: Battery Charging
Battery Charging A built-in battery is installed in the Toshiba Pocket PC. When using the Toshiba
Pocket PC for the first time, set the battery switch to the supply side, and then charge the built-
in battery with the supplied AC adapter.

Page 22: How To Prolong Battery Life
■ Do not leave the Toshiba Pocket PC in a place of high or low temperature. It may shorten
battery life. If you have not used the Toshiba Pocket PC for several days, its battery charge level
reading may be inaccurate.

Page 23: Initial Setup
The built-in battery gradually discharges even if the device is not being used. When the Toshiba
Pocket PC is left for a long time, the built-in battery of the Toshiba Pocket PC may completely
discharge. As a precaution, it is recommended that you save the Toshiba Pocket PC’s memory
data to your computer or to a storage card.

Page 24: Method Of Setting Card Into Sd Card Slot
When the Complete screen appears, the initial setup is completed. ■ After tapping the screen,
you can use the Toshiba Pocket PC. When you tap the Complete screen, the Today screen
appears. For more information , see “Today screen” in this chapter.

Page 25: Connecting To A Computer
The connectable pin size of the headphone/earphone is ø3.5 mm mini plug type. Connecting to
a Computer Before connecting your Toshiba Pocket PC to a computer, check the following. ■
ActiveSync has been installed on your computer. (See Chapter 3.) ■...
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Page 26: To Connect Using The Supplied Cradle
To Connect Using The Supplied Cradle: Connect the Client cradle to your computer as shown in
the illustration below. Insert the Pocket PC into the cradle. User's Manual Basic Skills 2-10...

Page 27: To Connect Directly Using A Connection Cable
Basic Skills To connect directly using a connection cable: Connect the Pocket PC directly to your
computer using an optional USB Client cable. When the Pocket PC is connected to another
device via a USB Client cable do not plug the AC adapter directly into the Pocket PC as this may
lead to interference.

Page 28: Today Screen
Today Screen When you turn on your device for the first time each day (or after 4 hours of
inactivity), you’ll see the Today screen. You can also display it by tapping and then Today. On
the Today screen, you can see at a glance important information for the day.

Page 29 Following are some of the status icons you may see. Status Icon If more notification
icons need to be displayed then there is room to display them, the Notification icon, notification
icons. User's Manual Meaning Turns all sounds on and off Backup battery is low Main batteries
are charging Main batteries are low...

Page 30: Programs
Drag the stylus off the label so that the command is not carried out. The following table
contains a partial list of programs that are on your device. Look on the Toshiba Pocket PC
Companion CD for additional programs that you can install onto your device. Icon...

Page 31: Navigation Bar And Command Bar
Navigation Bar and Command Bar The navigation bar is located at the top of the screen. It
displays the active program and current time, and allows you to switch to programs and close
screens. Use the command bar at the bottom of the screen to perform tasks in programs.

Page 32: Pop-Up Menus
Pop-up Menus With pop-up menus, you can quickly choose an action . For example, you can use
the pop-up menu in the contact list to quickly delete a contact, make a copy of a contact, or
send an e-mail message to a contact. The actions in the pop-up menus vary from program to
program.

Page 33: Enter Information On Your Toshiba Pocket Pc
Enter Information on Your Toshiba Pocket PC You have several options for entering new
information: ■ Use the input panel to enter typed text, either by using the soft keyboard or
other input method ■ Write directly on the screen ■...

Page 34: To Type With The Soft Keyboard
When you use the input panel, your device anticipates the word you are typing or writing and
displays it above the input panel. When you tap the displayed word, it is inserted into your text
at the insertion point. The more you use your device, the more words it learns to anticipate.

Page 35: To Use Block Recognizer
To use Block Recognizer: With Block Recognizer you can input character strokes using the stylus
that are similar to those used on other devices. Tap the arrow next to the Input Panel button
and then Block Recognizer. Write a letter in the box. When you write a letter, it is converted to
typed text that appears on the screen.

Page 36: Writing On The Screen
Writing on the Screen In any program that accepts writing, such as the Notes program, and in
the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to write directly on the
screen. Write the way you do on paper. You can edit and format what you’ve written and
convert the information to text at a later time.
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Page 37: To Convert Writing To Text
To convert writing to text: ■ Tap Tools and then Recognize. If you want to convert only certain
words, select them before tapping Recognize on the Tools menu (or tap and hold the selected
words and then tap Recognize on the pop-up menu). If a word is not recognized, it is left as
writing.

Page 38 If the conversion is incorrect, you can select different words from a list of alternates
or return to the original writing. To do so, tap and hold the incorrect word (tap one word at a
time). On the pop-up menu, tap Alternates.

Page 39: Drawing On The Screen
Drawing on the Screen You can draw on the screen in the same way that you write on the
screen. The difference between writing and drawing on the screen is how you select items and
how they can be edited. For example, selected drawings can be resized, while writing cannot.

Page 40: Recording A Message
Recording a Message In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a message. In Calendar,
Tasks, and Contacts, you can include a recording in the Notes tab. In the Notes program, you
can either create a standalone recording or include a recording in a written note.

Page 41: Using My Text
Basic Skills Using My Text When using Inbox or MSN Messenger, use My Text to quickly insert
preset or frequently used messages into the text entry area. To insert a message, tap My Text
and tap a message. You can add text after inserting a My Text message before sending it. To
edit a My Text message, in the Tools menu, tap Edit and then tap My Text Messages .

Page 42: Find And Organize Information
Find and Organize Information The Find feature on your device helps you quickly locate
information. ■ On the data type, and then tap Go to start the search. To quickly find
information that is taking up storage space on your Pocket PC, select Larger than 64 KB in Type.

Page 43: Customize Your Toshiba Pocket Pc
*.xip, *.exe,, or *.zip file, a Setup.exe file, or several versions of files for different device types
and processors. Be sure to select the program designed for the Toshiba Pocket PC and your
device processor type. User's Manual...

Page 44: To Add A Program To The Start Menu
Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions. Connect your device and
desktop computer. Double-click the *.exe file. ■ If the file is an installer, the installation wizard
will begin. Follow the directions on the screen.

Page 45: Setting A Password
Setting a Password You can protect data or settings from a third person by setting a password
which is requested when turning power on. and then Settings. On the Personal tab, tap
Password. Select the type of password you would like to use. Enter a password and tap OK.

Page 46: Setting Memory
Setting Memory You can adjust the data storing memory and the program running memory. You
can also confirm the free space of a storage card and so on. Memory for the Pocket PC is
managed automatically. To change Memory allocation: and then Settings.

Page 47: Chapter 3 Microsoft Activesync
Before you begin synchronization, install ActiveSync on your PC from the Toshiba Pocket PC
Companion CD. For more information on installing ActiveSync, see your Quick Start card.
ActiveSync is already installed on your device.

Page 48 After your first synchronization, take a look at Calendar, Contacts, and Tasks on your
device. You’ll notice that information you’ve stored in Microsoft Outlook on your PC has been

https://capturecode.com/manual/180359/Toshiba-E310.html?page=37#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=38#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=39#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=40#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=41#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=42#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=43#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=44#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=45#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=46#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=47#manual
https://capturecode.com/manual/180359/Toshiba-E310.html?page=48#manual


copied to your device, and you didn’t have to type a word. Disconnect your device from your PC
and you’re ready to go! Once you have set up ActiveSync and completed the first
synchronization process, you can initiate synchronization from your device.

Page 49: Chapter 4 Microsoft Pocket Outlook
TOSHIBA Pocket PC e310 Microsoft Pocket Outlook ® Microsoft Pocket Outlook includes
Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or
together. For example, e-mail addresses stored in Contacts can be used to address e- mail
messages in Inbox.

Page 50: Calendar: Scheduling Appointments And Meetings
Calendar: Scheduling Appointments and Meetings Use Calendar to schedule appointments,
including meetings and other events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu. You
can customize the Calendar display, such as changing the first day of the week, by tapping
Options on the Tools menu.

Page 51: To Create An Appointment
To create an appointment If you are in Day or Week view, tap the desired date and time for the
appointment. Tap New. Using the input panel, enter a description and a location. Tap first to
select the field. If needed, tap the date and time to change them. Enter other desired
information.

Page 52: Using The Summary Screen
Using the Summary Screen When you tap an appointment in Calendar, a summary screen is
displayed. To change the appointment, tap Edit. Creating Meeting Requests You can use
Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will
be created automatically and sent either when you synchronize Inbox or when you connect to
your e-mail server.

Page 53: Contacts: Tracking Friends And Colleagues
Contacts: Tracking Friends and Colleagues Contacts maintains a list of your friends and
colleagues so that you can easily find the information you’re looking for, whether you’re at
home or on the road. Using the device infrared (IR) port, you can quickly share Contacts
information with other device users.

Page 54: To Create A Contact
To create a contact: Tap New. Using the input panel, enter a name and other contact
information. You will need to scroll down to see all available fields. To assign the contact to a
category, scroll to and tap Categories and select a category from the list.

Page 55 Using the Summary Screen When you tap a contact in the contact list, a summary
screen is displayed. To change the contact information, tap Edit. User's Manual Microsoft Pocket
Outlook View contact details. Tap to change contact information. Tap to view notes.

Page 56: Tasks: Keeping A To Do List
Tasks: Keeping a To Do List Use Tasks to keep track of what you have to do. To change the way
information is displayed in the list, tap Tools and then Options. User's Manual Microsoft Pocket
Outlook Select the category of tasks you want displayed in the list.

Page 57: To Create A Task
To create a task: Tap New. Using the input panel, enter a description. You can enter a start date
and due date or enter other information by first tapping the field. If the input panel is open, you
will need to hide it to see all available fields.

Page 58 Using the Summary Screen When you tap a task in the task list, a summary screen is
displayed. To change the task, tap Edit. User's Manual Microsoft Pocket Outlook View task
details. Tap to show and hide additional summary information. View notes.
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Page 59: Notes: Capturing Thoughts And Ideas
Notes: Capturing Thoughts and Ideas Quickly capture thoughts, reminders, ideas, drawings, and
phone numbers with Notes. You can create a written note or a recording. You can also include a
recording in a note. If a note is open when you create the recording, it will be included in the
note as an icon.

Page 60: Inbox: Sending And Receiving E-Mail Messages
To create a note: Tap New. Create your note by writing, drawing, typing, and recording. For
more information about using the input panel, writing and drawing on the screen, and creating
recordings, see Chapter 2. Inbox: Sending and Receiving E-mail Messages Use Inbox to send
and receive e-mail messages by synchronizing e-mail messages with Microsoft Exchange or
Microsoft Outlook on your PC.

Page 61: Using The Message List
Using the Message List Messages you receive are displayed in the message list. By default, the
most recently received messages are displayed first in the list. When you receive a message,
tap it to open it. Unread messages are displayed in bold. User's Manual Microsoft Pocket
Outlook Select the service and folder you want to display.

Page 62: Composing Messages
When you connect to your e-mail server or synchronize with your desktop computer, by default,
you’ll receive messages from the last five days only, the first 100 lines of each new message,
and file attachments of less than 100 KB in size. The original messages remain on the e-mail
server or your desktop computer.

Page 63 Compose your message. To enter preset or frequently used messages, tap My Text
and select a message. Tap Send when you’ve finished the message. If you are working offline,
the message is moved to the Outbox folder and will be sent the next time you connect.

Page 64 Microsoft Pocket Outlook ■ If you use IMAP4, the folders you create and the e-mail
messages you move are mirrored on the server. Therefore, messages are available to you
anytime you connect to your mail server, whether it is from your device or desktop computer.

Page 65: Chapter 5 Companion Programs
TOSHIBA Pocket PC e310 Companion Programs The companion programs consist of Microsoft
Pocket Excel, Windows Media™ Player, and Microsoft To switch to a companion program on your
device, tap Programs on the menu, and then tap the program name. Pocket Word Pocket Word
works with Microsoft Word on your desktop computer to give you easy access to copies of your
documents.

Page 66 Pocket Word contains a list of the files stored on your device. Tap a file in the list to
open it. To delete, make copies of, and send files, tap and hold a file in the list. Then, select the
appropriate action on the popup menu. You can enter information in Pocket Word in one of four
modes (typing, writing, drawing, and recording), which are displayed on the View menu.

Page 67: Typing Mode
Typing Mode Using the input panel, enter typed text into the document. For more information
on entering typed text, see Chapter 2. To format existing text and to edit text, first select the
text. You can select text as you do in a Word document, using your stylus instead of the mouse
to drag through the text you want to select.

Page 68: Writing Mode
Writing Mode In writing mode, use your stylus to write directly on the screen. Ruled lines are
displayed as a guide, and the zoom magnification is greater than in typing mode to allow you to
write more easily. For more information on writing and selecting writing, see Chapter 2.

Page 69: Drawing Mode
Drawing Mode In drawing mode, use your stylus to draw on the screen. Gridlines appear as a
guide. When you lift your stylus off the screen after the first stroke, you’ll see a drawing box
indicating the boundaries of the drawing. Every subsequent stroke within or touching the
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drawing box becomes part of the drawing.

Page 70: Pocket Excel
Pocket Excel Pocket Excel works with Microsoft Excel on your desktop computer to give you
easy access to copies of your workbooks. You can create new workbooks on your device, or you
can copy workbooks from your desktop computer to your device. Synchronize workbooks
between your desktop computer and your device so that you have the most up-to-date content
in both locations.

Page 71: Msn Messenger
Tips for Working in Pocket Excel Note the following when working in large worksheets in Pocket
Excel: ■ View in full-screen mode to see as much of your worksheet as possible. Tap View and
then Full Screen. To exit full-screen mode, tap Restore.

Page 72: Working With Contacts
Setting Up Before you can connect, you must enter Passport or Exchange account information.
To set up an account and sign in: In the Tools menu, tap Options . In the Accounts tab, enter
your Passport or Exchange account information. To sign in, tap the sign-in screen and enter
your e-mail address and password.

Page 73: Chatting With Contacts
Chatting with Contacts Tap a contact name to open a chat window. Enter your message in the
text entry area at the bottom of the screen, or tap My Text to enter a preset message, and tap
Send. To invite another contact to a multi-user chat, in the Tools menu, tap Invite and tap the
contact you want to invite.

Page 74 To know if the contact you are chatting with is responding, look for the message
under the text entry area. For more information on using MSN Messenger, tap User's Manual
Companion Programs View full chat. View status of the chat. and then Help.

Page 75: Windows Media Player
Windows Media. Use Microsoft Windows Media Player on your desktop computer to copy digital
audio and video files to your Toshiba Pocket PC. You can play Windows Media and MP3 files on
your Toshiba Pocket PC. For more information about using Windows Media Player for Toshiba...

Page 76: Microsoft Reader
Sample books and a dictionary are also included in MSReader in the Extras folder on the
Toshiba Pocket PC Companion CD. Use ActiveSync to download the files from your desktop
computer to your activated device as described in the Read Me file in the MSReader folder.

Page 77: Using The Library
Using the Library The Library is your MSReader home page; it displays a list of all books stored
on your device or storage card. To open the Library: ■ On the MSReader command bar, tap
Library. ■ On a book page, tap the book title, and then tap Library on the popup menu.

Page 78: Using Reader Features
In addition to the text, each book page includes a page number and book title. You can also
page through a book by using the Up/Down control on your device. Using Reader Features
Reading a book electronically gives you several options not available with paper books.

Page 79: Removing A Book
■ Drawings: When you add a drawing, a Drawing icon appears in the bottom-left corner of the
page, and drawing tools appear across the bottom of the page. Draw by dragging your stylus. ■
To see a list of a book’s annotations, including bookmarks, highlights, text notes, and drawings,
tap Annotations Index on the book’s cover page.

Page 80: Chapter 6 Pocket Internet Explorer
TOSHIBA Pocket PC e310 Pocket Internet Explorer Use Microsoft either of these ways: ■ During
synchronization with your desktop computer, download your favorite links and mobile favorites
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that are stored in the Mobile Favorites subfolder in Internet Explorer on the desktop computer.

Page 81: Mobile Favorites
Mobile Favorites If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device. Synchronizing mobile favorites
downloads Web content to your device so that you can view pages while you are disconnected
from your ISP and desktop computer.

Page 82: Using Avantgo Channels
Using AvantGo Channels AvantGo is a free interactive service that gives you access to
personalized content and thousands of popular Web sites. You subscribe to AvantGo channels
directly from your device. Then, you synchronize your device and desktop computer, or connect
to the Internet to download the content.

Page 83: To View Mobile Favorites And Channels
To view mobile favorites and channels: Tap the Favorites button to display your list of favorites.
Tap the page you want to view. You’ll see the page that was downloaded the last time you
synchronized with your desktop computer. If the page is not on your device, the favorite will be
dimmed.

Page 84: Chapter 7 Getting Connected
TOSHIBA Pocket PC e310 Getting Connected You can use your device to exchange information
with other mobile devices as well as your desktop computer. You have the following connection
options: ■ Use the infrared (IR) port on your device to send and receive files between two
devices.

Page 85: Get Help On Connecting
Get Help on Connecting More information on the procedures described here, as well as
information on additional procedures, can be found in the following locations: ■ Inbox: Sending
and Receiving E-mail Messages in Chapter 4. ■ Online Help on the Pocket PC. Tap Installed
Help, and then Inbox or Connections.

Page 86: Chapter 8 Optional Functions
Launching an Application From the Home , Programs, and then Home to display the Home
screen. You can also launch the Home by pressing the Toshiba Pocket PC Home button. Tap to
select Paste or Add.

Page 87: About Running
Also, you can launch an application by moving the cursor button or scroller to select and
pressing the center of the cursor button to confirm. You can add tabs up to a maximum of 10
kinds and icons up to 18 in a tab.

Page 88: Display Icon List
Display Icon List The following list shows the tabs and icons for the initial setup. Tabs Running
Main Programs Games Moving an Application Icon into Another Tab The moved icon is placed
next to the last icon on the tab screen. You cannot move an icon into a tab which already
contains 18 icons.

Page 89: Deleting An Icon
If the Application file is not designated, or if the Application name is not entered, you cannot
add a new icon. You cannot launch the icon added from the storage card, if the same card is not
inserted in the Toshiba Pocket PC. User's Manual Optional Functions Tap to designate a folder
you want to browse.

Page 90: Tab Setting
Tab Setting You can set to add, delete or rename the tab on the Tab Settings screen. You can
also set to display a desired bitmap image on your screen background. To add a tab: Tap Tools
and then Tab Settings to display the Tab Settings screen. Tap Tab Settings and then New to
display a box to enter the new tab name.
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Page 91: Home Help
To change a background: Tap Tools and then Tab Settings to display the Tab Settings screen.
Select the tab of which background you want to change. Tap Browse to display the Browse
dialog screen. Tap the desired bitmap file from the list to return to the Tab Settings screen.

Page 92 (2).Launching applications When an icon on the tab screen is tapped, the application
or associated file registered at the icon is launched. ■ Applications can also be launched by
selecting them with the cursor button then pressing on the center of the cursor button.
(3).Switching the icon display Tap on the “View”...

Page 93 3. Adding icons Tap the tab to which you want to add an icon to select that tab. Tap
“Add” from the “Edit” menu to display the “Add Application” screen. Tap the “Application file”
box. From the list, tap the application you want to add. To select a file not on the list, tap the
“Browse”...

Page 94 Tap the “OK” button. The tab name is changed and the “Tab Settings”screen
reappears. Tap “OK” at the upper right to return to the Home screen. 3. Deleting tabs Select
“Tab Settings” from the “Tools” menu. The “Tab Settings” screen appears. Tap the “Select
tab”...

Page 95: How To Make A Backup
How to Make a Backup You can make a backup of the Toshiba Pocket PC data to a SD Memory
Card. If you have backed up your data on a SD Memory card, you can restore that data in your
Toshiba Pocket PC. You can also delete backup file data from the SD Memory card.

Page 96: Making A Backup
Making a Backup Insert an SD Memory Card. Tap Start, Programs, and then DataBackup to
display the DataBackup screen. Set a Custom Name, if you want. Tap Backup to display the
Prompt message screen. Tap OK. The Proceeding message is displayed during the backup
process.

Page 97: Carrying Out Restore Operation
To restore is to overwrite the backed up data from the SD Memory card onto the main memory
of your Toshiba Pocket PC. If the same file name exists in the main memory of your Toshiba
Pocket PC, the file data is replaced with the backup data from the SD Memory card.

Page 98: Data Backup Help
Data Backup Help The backup function allows you to back up the data from the main unit on
storage cards. The backed up data can be restored and deleted. Before performing the backup
or restore operation, check that there is enough space in the main unit’s memory and on the
storage card.

Page 99 (4).Deleting a backup file Select “DataBackup” from “Programs” in the “Start” menu.
Once the backup screen appears, tap the “Restore” tab. Select a backup file from the Restored
Files list. Tap the “Delete” button. A message screen asking you to confirm that you want to
delete the backup file appears.

Page 100: Chapter 9 Additional Information
TOSHIBA Pocket PC e310 Additional Information Troubleshooting Check the following guide for
the possible cause of a problem and how to correct it. Symptom The power button is pressed
but the power does not turn on. The power was suddenly cut off.

Page 101 Symptom The screen was tapped, but there is no response. The operation button
does not work either. The screen is dark. The screen is hard to see. Can not connect to your
computer. ActiveSync does not function when your Pocket PC is connected to your computer
with a USB cradle or USB cable.

Page 102: Resetting
When the power is on, press the reset button with the stylus, then release. Initializing When you
initialize your Toshiba Pocket PC, it returns to the status when it was purchased. When you
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initialize your Pocket PC, all data stored in the memory isdeleted.

Page 103: Specifications
Specifications External dimensions Weight Operating conditions Temperature: 0°C to 40°C,
Humidity: 30 to 80% Built-in battery Type Continuous operating time Memory keeping time
Processor Action clock Memory Display User's Manual 78.75mm(W) x 15.25mm(D) x
124.5mm(H) 142g (5oz) RH, when only the Pocket PC is operating Temperature capable of
charging: 5°C to 35°C Advanced Lithium Ion battery Approx.

Page 104 Interfaces SD card slot Infrared port Stereo headphone jack Cradle connection port
DC-IN Socket AC adaptor Although the display is manufactured using an extremely high order of
technology, there may be a case that some dots do not light or always light.
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